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1. Sc

ope

This document describes the e-POP raw and level 1+ data sets, including data formats,
quality indicators, algorithms used for generation of level 1+ products, and a guide for use
of the data. e-POP data archival is also discussed.
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2. Documentation

2.1 Applicable Documents

AD-1 ePOP-5024 e-POP Instrument Raw and Processed Data Formats REV A.pdf
AD-2 MGF_data_block_v3.pdf

AD-3 OEM4 User Manual Volume 1 Rev 19.pdf

AD-4 OEM4 User Manual Volume 2 Rev 18.pdf

AD-5 rinex302.pdf

Table 1: Applicable documents

2.2 Reference Documents

RD-1 The CERTO Beacon on CASSIOPE/e-POP and Experiments using High-Power HF
lonospheric Heaters, Space Sci. Rev. (2014) DOI: 10.1007/s11214-014-0110-2

RD-2 Fast Auroral Imager (FAIl) for the e-POP Mission, Space Sci. Rev. (2014)
DOI: 10.1007/s11214-014-0107-x

RD-3 ePOP-4771 FAI_Characterization_Report_Rev_A.pdf

RD-4 The GPS attitude, positioning, and profiling experiment for the enhanced polar
outflow probe platform on the Canadian CASSIOPE satellite, Geomatica (2010),
64(2), 233-243

RD-5 Imaging and Rapid-Scanning lon Mass Spectrometer (IRM) for the CASSIOPE e-
POP Mission, Space Sci. Rev. (2015) DOI: 10.1007/s11214-015-0149-8

RD-6 The CASSIOPE/e-POP Magnetic Field Instrument (MGF), Space Sci. Rev. (2014)
DOI: 10.1007/s11214-014-0105-z

RD-7 The e-POP Radio Receiver Instrument on CASSIOPE, Space Sci. Rev. (2015)
DOI: 10.1007/s11214-014-0130-y

RD-8 The CASSIOPE/e-POP Suprathermal Electron Imager (SEI), Space Sci. Rev.
(2015) DOI: 10.1007/s11214-015-0151-1

Table 2: Reference documents
3. Acronyms

A list of the acronyms used in this document are given in Table 3.

The information contained herein is proprietary to the University of Calgary
ePOP-5025




UNIVERSITY OF

e-POP Data User’'s Manual — Rev A

CALGARY Page -6 -
CASSIOPE Cascade Smallsat lonospheric Polar Explorer
CCD Charge Coupled Device
CERTO Coherent Electromagnetic Radio Tomography
e-POP Enhanced Polar Outflow Probe
eSOC e-POP Science Operation Center
DHUC Data Handling Unit Card
FAI Fast Auroral Imager
GAP GPS Attitude, Positioning, and Profiling Experiment
GPS Global Positioning System
HDF5 Hierarchical Data Format version 5
IR Infrared
IRM Imaging and Rapid Scanning lon Mass Spectrometer
IvO Level O
Ivl,lv2,lv3 Level 1, Level 2, Level 3
MCP Microchannel Plate
MGF Magnetic Field Instrument
MOS Mission Operation System
NMS Neutral Mass Spectrometer
NRL United States Naval Research Lab
RINEX Receiver Independent Exchange Format
RRI Radio Receiver Instrument
SEI Suprathermal Electron Imager
uT Universal Time

Introduction

Table 3: List of Acronyms

The e-POP payload consists of eight scientific instruments on the CAScade Smallsat
lonospheric Polar Explorer (CASSIOPE) satellite, seven of which produce data onboard the
spacecraft. Data from these instruments are time-tagged and written to a data buffer on the
spacecraft, then downlinked to the ground as a single stream to produce the e-POP raw
data. The instrument-specific packets are separated from the raw stream and any packets
with an invalid CRC are removed, to produce the level O data set. Each instrument has its
own unique set of processes and algorithms applied to the level O data to produce
independent level 1+ products.

This document and the associated applicable and reference documents combine to
describe the level 0, level 1+, quicklook, and summary products. Software tools for some
e-POP instruments that are available through the e-POP Science Operation Center (eSOC)
are also described. Finally, the structure of the e-POP data processing and archival system
is presented.

5. Data File Formats

The raw, level 0+, and ephemeris data formats and coordinate systems are described in
detail in AD-1.

The information contained herein is proprietary to the University of Calgary
ePOP-5025
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6. Data Product Descriptions

6.1 Ephemeris

The CASSIOPE ephemeris data is produced as a plain text file, one for each day,
specifying the position, velocity, and attitude of the spacecraft every 5 seconds in multiple
coordinate systems. The contents of the ephemeris data files are described in detail in
AD-1.

6.2 CERTO

The e-POP Coherent Electromagnetic Radiation TOmography experiment (CERTO) is for
radio transmission from e-POP to ground for radio propagation and ionospheric scintillation
measurements. It transmits at three frequencies, namely 150 MHz, 400 MHz, and 1067
MHz, through its three-frequency circular polarized antenna on a 68.6 cm boom. More
detail on CERTO may be found in RD-1.

The CERTO science data is captured on the ground at each receiver station. Stations run
by the U.S. Naval Research Lab (NRL) transfer data to the University of Calgary for
distribution.

6.2.1 CERTO NRL Receiver Science Data Format

6.2.1.1 its Files

The CERTO *.its files contain the raw data output. The naming convention is
“YYYYMMDDHHMMS.its™:

YYYY = year

MM = month

DD = day

HH = hour

MM = minute

S = station name first letter

The header contains the following:

Line 1 — date, time, and azimuth of satellite rise, the time, azimuth, and elevation of closest
approach, the time and azimuth of satellite setting, the satellite name, and the frequency
offset.

Line 2 — the receiving station name, latitude (in degrees), longitude (in degrees), elevation
(in meters) and time offset from GMT (in hours).

Line 3 — a line identifying the exact time of the first data point in the file and the data rate
Line 4 — the NASA two-line elements for CASSIOPE used to track the spacecraft

The data following is in counts, with 3277 counts equal to 1 Volt. The data column header
identifies the individual data samples.

The information contained herein is proprietary to the University of Calgary
ePOP-5025
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6.2.1.2 pro Files

File “YYYYMMDDHHMMS.pro” is the main processed data file, containing the Total
Electron Count computed for each second (which is a weighted average of 50 data points),
the azimuth and elevation of the satellite as viewed from the station, and the geocentric
latitude and longitude of the F-layer and E-layer penetration points of the line between the
satellite and the station.

Between the TEC and the Azimuth are three data quality flags.

Below that data set is another data set of the UHF S4, VHF S4 and RMS Phase computed
over 10 seconds.

File “YYYYMMDDHHMMS.pro” contains a header identical with the associated .its raw data
file header.

6.2.1.3 mag Files

File “YYYYMMDDHHMMS.mag” is a diagnostic file. It is only used to evaluate receiver
performance. Like the main processed data file, it contains the Total Electron Count
computed for each second (which is a weighted average of 50 data points), the azimuth
and elevation of the satellite as viewed from the station, and the data quality flags. Instead
of the penetration points, the last columns of data contain the signal strengths for VHF and
UHF (in counts), and the computed Signal-to-Noise ratio.

Below the main header and above the column headers are five lines of diagnostic data:
Noise Intensity (from the last five seconds of raw data after lock has been lost);
| channel average during the last five seconds;
Q channel average during the last five seconds;
Peak Signal-to-Noise (averaged over 60 seconds);
Peak signal intensity (averaged over 60 seconds).

6.2.1.4 sntFiles
File “YYYYMMDDHHMMS.snt” is a plotting file for plotting scintillation data. It is computed
for each data point. It contains the detrended intensities of UHF and VHF, and the relative

phase between them. If the data quality falls below certain thresholds, the values are set to
-999.999.

File “YYYYMMDDHHMMS.snt” contains a header identical with the associated .its raw data
file header.

The information contained herein is proprietary to the University of Calgary
ePOP-5025
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6.3 FAI

The e-POP Fast Auroral Imager (FAI) is a dual-CCD imager capable of producing images
in the near infrared (650-1000 nm) and visible (630 nm) regimes. A high-level description of
the instrument is available via RD-1. A more in-depth technical description of the
instrument, including details on calibration, image corrections, performance, and overall
characteristics, is available in RD-2.

6.3.1 FAIl Level O Data
The FAIl level 0 data is completely described in AD-1.

6.3.2 FAI Level 1 Products

FAI has four products that are derived from level 1 data: binary images, png images, a
quick look video, and a one-page summary plot. The level 1 image data are derived by
applying four corrections to the raw data.

1) Electronic offset removal
A non-zero DC offset is added to the signal as it is captured by the instrument and is
adjusted for on the ground. Each raw CCD image has up to 12 columns of ‘over-
scan’ pixels that do not accumulate counts from photons or dark current, which are
used to give an estimate of the DC offset for the image. The average of the counts in
the over-scan columns is calculated as a correction factor for the whole image.

2) Optical non-uniformity (vignetting) correction
The telecentric FAI lens system suffers from vignetting. Measurements were taken in
the lab prior to launch using a uniform integrating sphere to determine coefficients to
correct for the vignetting. Each pixel is scaled by a vignetting correction factor.

3) Dark current removal
Each pixel of a CCD accumulates counts even when it has no photons striking it,
during both exposure and readout. The rate of accumulation of dark counts is
heavily temperature-dependent for the two FAI CCDs. Pre-launch measurements
were taken to characterize the dark current for each pixel at a number of
temperatures; this library of information is used to correct the counts for each pixel in
every image. “Hot” pixels and columns were also included in this correction library.
For further details on the dark current subtraction please refer to RD-2.

4) Pincushion distortion correction
Pincushion distortion is apparent on the FAI images. Laboratory images of a
checkerboard allowed for coefficients to be determined for a constant correction set
to be applied to each camera of the form

Rper= ( aRmeas3+meeasz+CRmeas+d ) Rmeas

Where Ryperis the radius of the pixel in a perfect image, Rmeas is the measured radius,
and a, b, ¢, and d, are empirical coefficients.

The information contained herein is proprietary to the University of Calgary
ePOP-5025
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6.3.2.1  FAl Level 1 Binary Images

The detailed description of the level 1 binary data format can be found in RD-2. These files
are meant to be read by customized image processing software (e.g. FAItools).

6.3.2.2 FAl Level 1 png Images

FAIl level 1 data are available as a png image. A sample image is shown in Figure 1. The

printed header data include the following information:
e Camera name (e.g. e-POP FAI IR)

Date and time in UT of the start of the exposure (e.g. 2014-02-19 07:36:30 UT)

Exposure time in seconds (e.g. Exp=0.100s)

Image size in pixels (e.g. 256x256)

Signal range in image (e.g. DN=0-27791)

Satellite position in geographic latitude, longitude, and altitude (e.g. SC lat/lon/alt:

49.6°/-79.4°/670 km)

o Satellite attitude yaw, pitch, and roll angles, and attitude accuracy indicator [key:
U=Unknown, N=None, L=Low, H=High] (e.g. SC YPR: 0.0°/-0.3°/-0.0°/H). ‘Low’
accuracy attitude data is derived from the spacecraft coarse sun sensors, and ‘High’
accuracy data is derived from the star trackers. ‘None’ indicates that neither the sun
sensors nor the star trackers were available, while ‘Unknown’ indicates a loss of
attitude data.

e FAl level 1 software version (e.g. v4)

Figure 1: Sample FAI png image

The information contained herein is proprietary to the University of Calgary
ePOP-5025
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6.3.3 FAI Quicklook

The FAI quicklook videos show images from both FAI CCDs as well as ephemeris and
pointing information, and are sped up by a factor of ten for quick perusal. Figure 2 below is
a reference for interpreting the FAI quicklook videos.

The information contained herein is proprietary to the University of Calgary
ePOP-5025
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‘ @ e-POP FAI
7 . March 3, 2014
Infrared (650-1100 nm

@ 07:34:48.7 UT | Exp 0.100s / HighRes / -10.0C 07:34:19.4 UT / Exp 0.500s / MedRes / -20.0C
FAI_20140303 073448 (73449 00004 1C28.0.0 FAl_20140303 073419 (073420 D000A_CCDIWD
_ IR Signal (DN) VIS Signal (DN) _
T F ]
0 579 1357 2036 274 3393 4071 0 376 752 1128 1503 1879 2255
CASSIOPE
Altitude:; 375.5 km
Latitude: 63.1°
Longitude: - -95.4°
Miat: 715
MLT: 0.4h
IGRF Footprint
Altitude:; 110.0 km
Latitude: 63.2"
Longitude: 954°
Miat; 71.8
Mion: -34.1°

Solar Inclination: 328

+ Geographic location directly below Cassiope

| Past f-minute intesvals

* Future 1-minute imervals

Produced by FAIQL version 1.1 Gnid shows linas of magnietic latlon, circle is camara field of view

1 — Date for when images were taken

2 — Latest image from the infrared (650-1100 nm) camera

3 — Latest image from the visible (630 nm) camera

4 — Infrared image information: Time of start of exposure (UT),
exposure (s), mode (HighRes=256x256, MedRes=128x128,
LowRes=64x64), CCD Temperature (°C), image filename

5 — Visible image information: see #4 above

6 — View of the Earth from the satellite position. Time of view
carresponds with the most recent image on the plot. Gridlines
are lines of constant magnetic latitude and longitude.

7 — Satellite and IGRF information. Data correspond to the
time of the most recent image on the plot.

Figure 2: FAI quicklook video help page

The information contained herein is proprietary to the University of Calgary
ePOP-5025
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6.3.4 FAlI Summary Plots

Figure 3 shows a sample summary plot from October 29, 2016. The top panel is a time
series of the center image column taken from successive images from the infrared camera.
The second panel is the same but for the visible camera. The third panel is a plot of the
mean signal from the 20x20 central area of each camera. Solar inclination is plotted in the
fourth panel, imaging mode in the fifth panel (Overscan = 256x320 pixels including an extra
40 over-scan columns, High Res = 256x280 pixels including 24 non-imaging columns, Med
Res = 128x140 pixels including 12 non-imaging columns, Low Res = 64x70 pixels including
6 non-imaging columns), and exposure time for each camera is plotted in the bottom panel.
Time in UT along with spacecraft ephemeris is plotted on the x-axis. Altitude is in km,
geographic latitude and longitude are in degrees, magnetic latitude is in degrees, and MLT
IS in hours.

The information contained herein is proprietary to the University of Calgary
ePOP-5025
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October 29, 2016

» e-POP FAI Summary Plot
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Figure 3: FAlI Summary Plot Sample

6.4 GAP

The GPS Attitude, Positioning, and Profiling Experiment (GAP) combines five dual-
frequency NovAtel GPS receivers and associated antennas to produce real-time position,
attitude, and timing information onboard CASSIOPE. A detailed overview of the GAP
instrument and its qualification process can be found in RD-4.

The information contained herein is proprietary to the University of Calgary
ePOP-5025
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6.4.1 GAP Level 0 Data
The GAP level 0 data is described in detail in AD-1.

6.4.1 GAP Level 1 Products

The GAP level 1 data products are split by GAP GPS receiver number and are binary-type
data files consisting of the raw output from the NovAtel GPS receivers. The filename
convention is as follows:

GAP_YYYYMMDD HHMMSS hhmmss RCVR N _vX-Z.lvl

Where

YYYY = year, MM = month, DD = day, HH = start hour, MM = start minute, SS = start second,
hh = end hour, mm = end minute, ss = end second, N = GAP receiver number (0-4), X =
major revision number, Z = minor revision number. All times are in UT. The GAP GPS
antenna locations are shown in Figure 5. The antenna numbers match the receiver
numbers. Instructions for decoding the GAP level 1 data can be found in AD-3 and AD-4.

GPS-0 ; GPS-3

RAM (+X)
(+tY)

-

NADIR (+Z)

Figure 4: GAP GPS antenna placements

6.4.2 GAP Level 2 Products

The GAP level 2 products are presented in the Receiver INdependent EXchange (RINEX)
format, version 3.02. These files are of ASCII type and are produced by the NovAtel-
supplied “Convert4” software, operating on the GAP level 1 data files. See AD-5 for a
complete description of RINEX files. There are two types of RINEX files produced for GAP;
O (observation) and N (navigation), and each share the same name as the Iv1 file it was
created from, save for the file extension.

The information contained herein is proprietary to the University of Calgary
ePOP-5025
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6.4.3 GAP Quicklook

The GAP quicklook plot shows when and, if possible, where GPS messages were received
on a given day. Figure 4 shows a sample GAP quicklook plot from March 5, 2016. The top
panel is a map showing the time and location of all messages where position was
calculated. The start and end timestamps are shown adjacent to the start and end of each
pass. The points are colour coded to show whether the GPS lock status was unknown
(black), coarse steering (blue), or fine steering (green).

The middle panel plots a time series of the number of GPS satellites that GAP was able to
lock to, with the colour and shape of the points indicating the type of messages received.

The bottom panel is a complete summary list of all types of GPS messages received and
how many messages were received by each GAP receiver. Refer to AD-4 for a detailed
description of the GPS message types (e.g. RAWEPHEM, ID41, etc).

The information contained herein is proprietary to the University of Calgary
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e-POP GAP
March 5, 2016

20:25: 3% U534 UT
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13:21:28 L}

| —  Unknown —  CoarseSteering ——  FineSteering |
12
210
s &
2 g
S 2 A
UT 01:51:25 04:57:04 08:02:44 11:08:24 14:14:04 17:19:44 20:25:23
ALT 791.8 1249.6 1318.9 935.3 421.1 403.7 889.6
LAT 75.3 19.1 -34.9 -80.8 -22.0 48.5 63.5
LON -16.0 -96.3 -152.4 62.3 -55.8 -116.3 45.5
MLAT 77.6 27.9 -32.5 -82.8 -12.6 54.8 57.7
MLT 3.2 22.2 22.2 10.5 10.3 8.8 0.2
—  RAWEPHEMERIS PSRPOS = RANGE RANGECMP A& PSRXYZ @ smxvz|
Total # of GAP packets: 43574 Number of messages from:
Max # of locks: 12 VERSION (ID37): 0
RAWEPHEM (ID41): 0
Number of packets containing: RANGE (ID43): 9342
GPS0 Data: 18788 PSRPOS (ID47): 9263
GPS1 Data: 12123 RANGECMP (ID140): 395
GPS2 Data: 12268 VALIDMODELS (ID206): 0
GPS3 Data: 0 PSRXYZ (ID243): 15382
GPS4 Data: 395 SATXYZ (ID270): 9192
Attitude solution: 0 Unhandled: 0
Produced by GAPQL vi.1

uree sesslon filenames: GAP 201600385 015128 015136_00007_361C.W0 to
AP_20160305_184225_202524_0000C_B945 D

Figure 5: Sample GAP quicklook plot

6.5 IRM

The e-POP Imaging and Rapid-Scanning lon Mass Spectrometer (IRM) is an ion detector
capable of measuring ions in the 0.1-100 eV/q range, and is equipped with a time-of-flight
gate to mass resolve ions in the 1-40 amu/q range. A comprehensive overview of IRM can
be found in RD-5.

The information contained herein is proprietary to the University of Calgary
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6.5.1 IRM Level 0 Data
Level O IRM data files are described in AD-1.

6.5.2 IRM Quicklook

IRM quicklook videos, produced from IRM level 0 data, give an indication of instrument
health, settings, and quality of data captured by the instrument. Figure 6 shows a snapshot
from an IRM quicklook video.

The top left pane shows the IRM detector pixel layout and associated count rate for each
pixel including counts from all inner dome voltage settings for the time period indicated in
the title area. The magnetic field and anti-ram directions, projected into the plane of the
sensor, are overlaid as red and blue arrows, respectively. The zenith direction is indicated
by a black arrow in the middle of the frame, above the legend for the spacecraft X and Z
directions.

The bottom pane is a plot of the count rate for each time-of-arrival bin for all inner dome
voltage settings combined. The two left panes do not correct for background counts.
Background counts are those ions which pass through the time-of-flight gate when it is
closed. These ions can be accounted for by estimating their count rate in each pixel/time-
of-arrival bin by analyzing the counts in the upper time-of-arrival bins where no ion counts
should be detected.

The right upper and lower plots are the same as the left but include counts for a single VSA
step only at -260 V, with the estimated background counts removed.

The bottom of the quicklook shows the operating parameters and spacecraft location.
Descriptions of the operating parameters can be found in RD-5.

The information contained herein is proprietary to the University of Calgary
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Produced by IRMQL v3.3 on Fri Oct 21 23:22:38 2016

Figure 6: IRM quicklook sample

6.5.3 IRM Summary Plot

IRM summary plots are a one-page time-series plot of pixel counts, time-of-arrival bin, skin
current, and total counts per second. A sample is shown in Figure 7. The top panel plots
the count rate in each pixel column (see the pixel layout of the IRM detector anode in
Figure 6) as a function of time. The y-axis labels indicate which pixel column is
represented, and within each column the counts on each pixel row are plotted from bottom
to top. For instance, in the —X row the pixel count rates for the inner most pixel (pixel
number 49 in Figure 6) is at the bottom of the row, and the count rate for outer most pixel
(pixel number 57 in Figure 6) is plotted at the top of the —X row. This is repeated for each
row in the top panel. Note that the colour-coded counts are shown in a ‘compressed log
scale’ where the top two decades are compressed compared to the bottom three. The
attitude of the spacecraft is shown by the solid, dotted, and dash-dot lines overlaid on the

plot, representing the direction of the magnetic field, anti-ram, and zenith directions,
respectively.

The information contained herein is proprietary to the University of Calgary
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The second plot from the top is a time series of the time-of-arrival bin counts. In this
example it is clear that there are at least two species present filling up two distinct time-of-
arrival bin ranges. Note that the colours are also plotted in the compressed log scale.

The next plot shows the current on the IRM outer skin in micro amps (positive indicating an
abundance of electrons on the skin), and the bottom panel plots the ‘hit counter’ and ‘detect
counter’ values. The *hit counter’ is incremented when two adjacent amplifiers on the IRM
anode register a count whereas the ‘detect counter’ is incremented when only one amplifier
records a count. These two values together give an indication of the spread of the electron
cloud produced by the microchannel plates that make up part of the IRM ion detection
assembly. The pixel counts in the top panel are made up of ‘hit counter’ counts.

The spacecraft ephemeris data is shown on the x-axis. IRM operating voltages and settings
are shown in the table below the plots. Refer to RD-5 for a description of the voltages and
operating modes of IRM.

The information contained herein is proprietary to the University of Calgary
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e-POP IRM Summary Plot
October 17, 2016
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Figure 7: Sample IRM summary plot

6.6 MGF

The e-POP MaGnetic Field instrument (MGF) consists of dual, tri-axial fluxgate
magnetometers mounted on an 80-cm carbon fibre boom for measurements of magnetic
field perturbations. Further details on all aspects of the MGF instrument may be found in
RD-6.

The information contained herein is proprietary to the University of Calgary
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6.6.1 MGF Level 0 Data
The MGF level 0 data is described in AD-1.

6.6.2 MGF Level 1 Data

The MGF level 1 processor uses the packet timestamps and sequence numbers to align
the MGF packets from the two magnetometers, tag in timestamps as they occur, and
unpack the binary packets into an ASCII file in unprocessed instrumental units. The level 1
MGF data is an internal product and is not recommended for routine use.

6.6.3 MGF Level 2 Data

The MGF level 2 processor applies the preflight ground calibration to the magnetic data
and metadata to convert to physical units, removes transients generated by instrumental
range changes, and interpolates the timestamps to create a best-estimate for the sampling
time of each data point. The level 2 MGF data is an internal product and is not
recommended for routine use.

6.6.4 MGF Level 3 Data

The MGF level 3 processor applies the pre-flight calibrations and removes the interaction
between the two MGF sensors. Eventually, the two instrument data streams will be merged
to estimate and remove the spacecraft field. Currently, the level 3 data is derived from a
single instrument. The spacecraft attitude solution is used to generate a second data
product by rotating the measured magnetic field into a geophysical geocentric equatorial
inertial (GEI) frame. Finally, the data is filtered and down-sampled to 10 and 1 samples per
second (sps) time series aligned to the GPS-derived second boundaries.

The Level 3 data is provided as ASCII files using the format defined in Table 4.

Column Name | Example Value Description
LV3 DESCRPT | LV3_MAGDATA This is magnetic data
Time (s) 1508041541.000000 | Seconds since the SMEX epoch (May 24 1968
00:00:00 UTC)
B_SCY (nT) 13643.928 B (nT) — Spacecraft X Coordinate
(Ram aligned in nominal spacecraft orientation)
B_SCZ (nT) 23858.315 B (nT) — Spacecraft Y Coordinate

(Cross-track aligned in nominal spacecraft
orientation)

B_SCZ (nT) 23858.315 B (nT) — Spacecraft Z Coordinate
(Nadir aligned in nominal spacecraft orientation)
B SCY (nT) 13643.928 B (nT) — GEI X Coordinate
B _SCZ (nT) 23858.315 B (nT) — GEI Y Coordinate
B SCZ (nT) 23858.315 B (nT) — GEI Z Coordinate
Loc X (GEI) -5.1343278192E+06 | Location — GEI X Component

The information contained herein is proprietary to the University of Calgary
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Column Name | Example Value Description
Loc Y (GEI) 4.0842133664E+06 | Location — GEI' Y Component
Loc Z (GEI) 3.6760843014E+06 | Location — GEI Z Component

Table 4: MGF level 3 data format description

6.6.5 MGF Quicklook Plot

The MGF quicklook plot is generated for each MGF turn-on session. Figure 8 shows a
sample plot. The top two panels show the Fourier power as a function of time and
frequency for the outboard (top) and inboard (bottom) sensors. Below those, in panel three,
is a plot of the total magnetic field for each magnetometer. The bottom two panels plot the
temperature of the sensors and the electronics cards for each magnetometer (top panel),
as well as the voltage monitor deltas (bottom panel), which is the difference between the
measured voltage and the expected voltage of the monitor circuit.

The data along the x-axis are, from top to bottom, UT time, altitude in km, geographic
latitude and longitude in degrees, magnetic latitude in degrees, and magnetic local time in
hours.

The information contained herein is proprietary to the University of Calgary
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Figure 8: MGF quicklook sample
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6.6.6

MGF Summary Plot

Figure 9 shows a sample MGF summary plot. The panels show the inboard magnetometer,
outboard magnetometer, and IGRF reference field for the x, y, z, and total field components
(top to bottom). The x-axis parameters are the same as those in the MGF quick look plots.
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The e-POP Neutral Mass and velocity Spectrometer (NMS) measures the mass
composition and velocity of neutral atmospheric species in the 1-40 amu mass and 0.1-2
km/s velocity range.
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Content will be added in a future release of this document.

6.7.1 NMS Quicklook Plot
Content will be added in a future release of this document.

6.8 RRI

The Radio Receiver Instrument (RRI) measures wave electric fields in the 10Hz - 18MHz
range, at magnitudes from 1 pV/m to 1 V/m. It has two input channels, each of which
connect to two, 3-m monopole antennas. A complete description of the RRI instrument can
be found in RD-7.

6.8.1 RRI Level 0 Data
RRI level O data is described in AD-1.

6.8.2 RRI Level 1 Data
RRI level 1 data utilizes the HDF5 file format and is described in detail in AD-1.

6.8.3 RRI Quicklook

The RRI quicklook is composed of spectrograms (measured antenna voltage as a function
of time and frequency) for both RRI input channels. Figure 8 shows a sample RRI quicklook
plot. The RRI settings are listed above the main panels, including settings for the channel
selectors (11, Q1, 12, Q2, 13, Q3, 14, or Q4 for each monopole), linear or dipole antenna
mode, and the gain settings (low, medium, or high). The spacecraft ephemeris is shown on
the x-axis below the Universal Time.

Linear and logarithmic sweeps over frequency are possible with RRI. The Fast Fourier
Transform is computed over 5208 samples by default but will vary if required by a shorter
dwell time of a frequency sweep.

The information contained herein is proprietary to the University of Calgary
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e-POP RRI
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Figure 10: Sample RRI quicklook

6.9 SEI

The e-POP Suprathermal Electron Imager (SEI) measures the electron energy and pitch
angle distribution over the energy range of 1 to 200 eV, with particular emphasis on
photoelectrons in the 1 to 50 eV range. It is also capable of measuring ions. A complete
description of the instrument is contained in RD-8.

6.9.1 SEIl Level 0 Data
The SEI level 0 data is described in AD-1.

6.9.2 SEI Quicklook

Like IRM, the SEI quicklook is a video product used to assess instrument health,
performance, and high-level data quality. An example frame is shown in Figure 9. The main
panel is a snapshot of the SEI CCD, cropped to the specified number of pixels based on
the instrument mode setting. CCD counts are displayed in a log scale and each image is
the average a number of images, typically 100. When available, the attitude information is
overlaid in the form of red and blue arrows, red for the magnetic field direction projected

The information contained herein is proprietary to the University of Calgary
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into the plane of the sensor, and blue for the anti-ram direction, also projected into the

plane of the sensor. The bottom portion of the plot shows the time, instrument settings, and
spacecraft position.

e-POP SEI
A September 19, 2015

ey 255
B—>»
Anti-RAM —»
S/C X 101 -
s/Icz
° a0-
z
Q
o 15
-
o
73]
6
2
0
Number of Images Averaged 100 S/C Position:
Time 07:59:55.830 UT Latitude -71.8°
Instrument Mode LOWRES Longitude 4.4
Instrument Detection Mode lon Mag Lat -73.2°
Inner Dome Voltage 213V MLT 88h
Skin Voltage 53V Altitude 4222 km
Phosphor Screen Voltage 4995.9V Solar Elevation  16.0°
MCP Front Voltage -2306.1 V B-field Elevation 0.3’
MCP Back Voltage 63.3V Ram Elevation 0.1°
Temperature 27.4°C
Summation Factor 0.0
FSW Version OxFO

Source session filename: SEI_20150919_075955_081050_0000F_2600.hv0
Produced by SEIQL v2.4 on Wed Sep 23 22:32:28 2015

Figure 11: SEI Quicklook Sample
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The SEI quicklook table data are described below.

Iltem Description

Instrument Mode SEI CCD operating mode. Modes include HIRES (64x64 pixels),
LOWRES (32x32 pixels), and INTEGRATION (32x32 pixels
integrated over a time indicated by the Summation Factor)

Instrument Particle detection mode, either Electron or lon.
Detection Mode

Inner Dome Voltage | Voltage on the inner dome of the hemispherical analyzer. This
controls the energy range of the detected particles.

Skin Voltage Voltage applied to the outer SEI skin
Phosphor Screen Voltage applied to the phosphor screen that sits between the CCD
Voltage and the microchannel plates.

MCP Front Voltage | Voltage applied to the top of the microchannel plates (MCP)

MCP Back Voltage | Voltage applied to the bottom of the microchannel plates

Temperature Temperature of the SEI sensor head. The temperature sensor
reports incorrect temperature values.

Summation Factor Number of images added together to get the final image

FSW version Version number of the onboard flight software

Latitude Spacecratft latitude

Longitude Spacecraft longitude

Altitude Spacecraft altitude

Solar Elevation Angle between the spacecraft position vector and the sun-earth
line

B-field Elevation Angle between the magnetic field and the SEI CCD plane

Ram Elevation Angle between the spacecraft ram direction and the SEI CCD
plane

Table 5: SEI operating parameters

6.9.3 SEI Summary Plot
Figure 10 shows an example SEI summary plot. The top panel is a plot of instrument
counts as a function of time and angle around the SEI CCD for the ring of pixels at a radius
of npix/2, where npix is the number of pixels in one dimension of the image. Note that the
counts are log scaled by colour.

The second panel plots counts as a function of time and energy. The energy of the
particles is determined from the pixel position and voltage on the SEI inner dome via the
following formula

E = 0.61141(r/32.0)* x |vInner|

where r is the radius of the illuminated pixel with respect to the image center (image center
is [34.5568, 33.1462] in hires mode), and vinner is the voltage on the inner dome.

The information contained herein is proprietary to the University of Calgary
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The first moment of the image is plotted in the second panel. The x and y first moments are
computed as follows:

N—1¢N-1
o = Yi=o Xj=o Xij Cij
m = TNN-IVvN-1
Zizo Zj:o Cij
N—1vN-1
_ Xi=o Xj=o Yij Cij

Ym = = -
HD DY ey

where C;; are the counts at the [i,j] pixel, x;;, y;; are the x and y position of the [i,j] pixel, and
N is the number of pixels in one dimension of the CCD.

The solar zenith angle is the angle between the sun and the local zenith direction, and is
plotted in the fourth panel.

The bottom panel shows the SEI mode as a function of time.

Other operating parameters are indicated above the top panel. See Table 5 for a
description of these values.

The spacecraft position is indicated on the x-axis. ALT is altitude in km, LAT is the
geographic latitude in degrees, LON is the geographic longitude in degrees, MLAT is the
magnetic latitude in degrees, and MLT is the magnetic local time in hours.

The information contained herein is proprietary to the University of Calgary
ePOP-5025



UNIVERSITY OF

e-POP Data User’'s Manual — Rev A

CALGARY Page - 31 -
e-POP SEI Summar;y Plot
e September 19, 201
VSKIN=-5.3V, VINNER=-21.4V, VMCPF=-2267V, VMCPB=62V, VPHOS=4921V" lon mode
ifigld 180 255
101
90 2
o
g 0E
£ 0 15 g
E 5 S
N o
<
80 o
2
-180 0
50 255
40 101
— =2
3 30 0'F
= 15 2
g 20 5
w 2] [=]
&)
10 p)
0
= X Moment
— E| ¥ Moment
[= |
L] = |
= =
(=) |
= E
# 3
o =
£5 100
sz g E
No a5 E
o o =
@< 7. E
o Analog .
o -
(=}
= _
i Normal
o HK | e . o o 1
UT 07:58:47 08:00:52 08:.02:57 08:05:02 08:07:07 08:09:12 08:11:18
ALT 4420 406.8 3794 360.3 350.1 348.9 357.0
LAT -67.8 -74.9 -80.2 -79.8 -74.1 -6B.7 -58.7
LON 357 48.5 79.1 128.7 156.7 168.5 174.5
MLAT -88.7 -77.0 -85.3 -86.3 -77.9 -69.5 -61.0
MLT 8.9 8.8 8.5 21.5 21.1 21.0 21.0
Produced by sei_summary v2.0 on Wed Sep 23 23:50:35 2015

7.

Figure 12: Sample SEI summary plot

e-POP Software Tools

e-POP software tools are available for general use and can be obtained by visiting
http://epop.phys.ucalgary.ca/data. All tools are written in the IDL language. IDL must be
installed on a local computer for use, however an IDL license is not required for most
functions. As of the writing of this document, the software suite can be used to read in and
display data from the FAI, IRM, RRI, and SEI data sets. At present, no publically available
software are available to display the data from CER, GAP, MGF, or NMS. Tools to
manipulate these remaining data sets will hopefully be available soon.
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7.1 FAI
FAIltools is a software package for viewing and geolocating FAI images.

£ FAI Tools v2.2
File Help

Data File Directory C:
File Name Fitter ~Iv1
Cument Date/Time: Sep 29, 2013 at 16:00:00.000 UT

Image | Satelite View Ratation

I ] of O

LESE Image Size

Load Files
|| White Background

|| User-Defined Caolorbar Scals

Thumbnail Viewer

Display Image

[] Show north on images
[~] Postscript Archive On
[[] Landscape

MNext Image

Row/Col Profiles

Map View Options

Read Pixel Values @ Use S/C position for map center

Magnify
Plot Header Info
56 Magnitude Lat (deg)
20 Speed Lon (deg)

[#] 1R {650-1100 nm} Alt (em)

() Use image latlon for map center

]
)
]
)
Frevious Image |
]
)
]
]

(7 Use custom settings for map center:

VIS (630 nm) Map rotation based on 5/C motion

Figure 13: FAItools main GUI

To start FAItools, double-click the FAItools.sav file and the main GUI should appear (Figure
13). To load images into the tool, enter in a path where your FAI level 1 images (*.lv1)
reside into the “Data File Directory” box, or click the “Browse” button and locate the folder.
Image names may be filtered before being loaded by utilizing the “File Name Filter” box.
Once these parameters are correctly entered, click the “Load Files” button.

Images can now be viewed as a bunch of thumbnails (“Thumbnail Viewer” button, Figure
14), one-by-one (“Display Image”, “Next Image”, and “Previous Image” buttons, Figure 15),
or as a movie (“Play Movie” button).
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Figure 14: FAItools thumbnail viewer
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Figure 15: FAItools image display with overlay

Geolocating images is done using the “Satellite View” tab on the main GUI. Select either
“Satellite View”, “Stereographic View”, or “Mercator View” first to set the map projection,
then add selected items to the output with the remaining buttons, e.g. “Project Image Onto
Map”, “Add Magnetic Grid”, and “Add Oval - Quiet Time = Unfilled” to get the view shown
in Figure 16 for November 26, 2016 at 10:18:24. The map view can be adjusted by editing
the fields in the “Map View Options” area as well.

Output from FAIltools can be created in two ways. For postscript output check the
“Postscript Archive On” button. This causes all subsequent displays to be directed to the
postscript file. Uncheck the archive button to close the file. Alternatively you may use the
“File” menu to select other outputs such as capturing the currently active window to a jpg
file, or to create specialized mp4 videos of images or map projections (e.g. see Figure 17).

General options include changing the default colour table (“File->Load Color Table”),
setting a custom colour bar scale (checking the “User-Defined Colorbar Scale”), and
selecting output from only the IR or VIS camera (“IR (650-1100nm)” and “VIS (630nm)”
checkboxes on the “Image” tab).
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e—POP FAl: 2016—-10-26 10:18:24.241 UT
Viewing Alt:  857.6 km Lot: 66.58 deg Lon: —135.74 deg

Figure 16: FAI satellite view
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e-POP FAI NIR

2016-03-07 04:33:47.324 UT
S/C Altitude 924.8 km

...................
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.....................................

I* IGRF Footprint at 110 km

Figure 17: FAItools video map projection

7.2 IRM

The IRMtools software is designed to view the raw IRM Iv0 data. It shows a graphical
display of ion counts on the IRM anode, can plot time-of-arrival bin histograms, as well as
plot IRM engineering housekeeping data. The IRM pixel anode is oriented such that pixel
column 3 (pixels 17-24) are aligned with the spacecraft X-axis, and pixel column 5 (pixels
33-40) are aligned with the spacecraft Z-axis.

Figure 18 shows the main IRMtools GUI. IRM IvO files are loaded by clicking the “Open...”
button and selecting a file. IRM packet data is displayed one at a time or in movie form,
with each packet’s data displayed in the left text area. Plots are created using the lower
boxed section, use the drop-down button to select a plot type, then click the “Plot” button to
display the plot. Plot options are also available below the “Plot” button. To save output to a
file select either “File - Capture Current Window...” or “File - Start Postscript File Log...".
To close the postscript file click “File - End Postscript Log”. While the postscript file log is
open all output will be sent to file and not to the screen.
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An IDL routine is provided to read the RRI Ivl HDF5 files, titled “read_rri_Iv1.pro”. Its usage
is as follows:

.compile read rri 1lvl

rri data = read _rri lvl([inputFileName], [sec_in=sec_in], $
[total sec=total sec], [decm=decm], [/geographic_interp], $
[/geomag_interp], [/gei gsm interp], [/attitude interp])

Optional Inputs Description

inputFileName Specifies the path to an rri hdfs file

sec_in Number of seconds into the file to start reading data from. Default
is the start of the file.

total_sec Number of seconds of data to read from the file. Default is to read
the entire file.

decm Decimation keyword to specify how to decimate the data -

program reads in one out of every decm data points.
geographic_interp | Interpolate the geographic ephemeris data to each radio_data
point. Default is 1 sample per second.

geomag_interp Interpolate the geomagnetic ephemeris data to each radio_data
point. Default is 1 sample per second.
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Optional Inputs Description
gei_gsm interp Interpolate the gei and gsm ephemeris data to each radio_data

point. Default is 1 sample per second.

attitude_interp Interpolate the attitude ephemeris data to each radio_data point.

Default is 1 sample per second.

Table 6: read_rri_Iv1 input parameters

Returned is a structure containing the following attributes:

Instrument Setting Description

gainl gain on antenna 1 (low, medium, or high)

gain2 gain on antenna 2 (low, medium, or high)

gain3 gain on antenna 3 (low, medium, or high)

gain4 gain on antenna 4 (low, medium, or high)

switch_k1 '‘Monopole’ or 'Dipole’ antenna configuration

sweep_mode_A Sweep mode for input A. 'Fixed Frequency', 'Linear Sweep',
or 'Logarithmic Sweep'

sweep_mode_ B Sweep mode for input B. 'Fixed Frequency', 'Linear Sweep',
or 'Logarithmic Sweep'

bandwidth A Bandwidth of input A, 5 or 30 kHz

bandwidth B Bandwidth of input B, 5 or 30 kHz

F1 A Frequency start for input A (MHz)

F2 A Frequency end for input A (MHz)

DF_A Delta frequency for input A (MHz)

DWELL A Time spent at each frequency on channel A (s)

F1 B Frequency start for input B (MHz)

F2 B Frequency end for input B (MHz)

DF B Delta frequency for input B (MHZz)

DWELL B Time spent at each frequency on channel B (s)

chan_A freq Array of values for each data point indicating the center
frequency (MHz) at that time for channel A

chan_B_freq Array of values for each data point indicating the center

frequency (MHz) at that time for channel B

data_format

Indicates data streams provided. Format is four of 'I1' 'Q1'
12''Q2"'13''Q3' 'I4' 'Q4', e.g. "I1Q1I3Q3". In dipole mode,
"11Q1I3Q3" means that the in-phase and quadrature
streams from dipole 1 and 2 are in the data. In monopole
mode, "11121314" means that the in-phase voltages from all
four monopoles are presented in the data stream.

gei Interpolated S/C position in GEI coordinates for each
antenna voltage (km)

vgei Interpolated S/C velocity in GEI coordinates for each
antenna voltage (km/s)

gsm Interpolated S/C position in GSM coordinates for each

antenna voltage (km)
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Instrument Setting

Description

lat

Interpolated geographic latitude for each antenna voltage
data point (deg)

lon Interpolated geographic longitude for each antenna voltage
data point (deg)

alt Interpolated geographic altitude for each antenna voltage
data point (km)

mlat Interpolated magnetic latitude for each antenna voltage data
point (deg)

mlon Interpolated magnetic longitude for each antenna voltage
data point (deg)

mit Interpolated magnetic local time for each antenna voltage
data point (h)

yaw Interpolated S/C attitude yaw value each antenna voltage
data point (deg)

pitch Interpolated S/C attitude pitch value each antenna voltage
data point (deg)

roll Interpolated S/C attitude roll value each antenna voltage
data point (deg)

radio_datal Antenna voltage data from data_format identifier #1, e.qg.
from 11, in mV

radio_data2 Antenna voltage data from data_format identifier #2, e.qg.
from Q1, in mV

radio_data3 Antenna voltage data from data_format identifier #3, e.g.
from 13, in mV

radio_data4 Antenna voltage data from data_format identifier #4, e.qg.
from Q3, in mV

time Time, in seconds, since May 24, 1968 at 00:00:00 UT, of

each radio_data set (data comes in sets of 4)

no_interp_ephemeris_time | Time, in seconds since May 24, 1968 at 00:00:00 UT, of

each non-interpolated ephemeris data point

Example use:

IDL> .r read rri 1lvl

Table 7: read_rri_Iv1 structure output

IDL> rri data = read rri 1v1(‘RRI_20140419 044348 044917 lvl v2.h5',
sec_in=10, total sec=20, decm=1)

IDL> dummy = label date('$H:%M:%S',OFFSET=JULDAY(05,24,1968,0,0,0.0d))
IDL> plot, rri data.time/86400.0d, rri data.radio_datal,
xtickformat='LABEL DATE', title='e-POP RRI April 19, 2014', xtitle='Time
(UT)’, ytitle = ‘Antenna 1 Voltage (mV)’
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Sample output:

EE—  wmaage

=—POP RRI April 15, 2014

Antenna 1 Yeoltage {mv)
o

-4 | | | | | | | | | | | | 1 |
04:435:58 O4rd4:02 G4 4406 Gt O4:44:15 444214
Time (UT)

Figure 19: Sample RRI data plot

7.4 SEI

The SEI Tools software is for visualizing the SEI level O data. Load an SEI IvO file by
clicking “Open...” and selecting a file. Images can be viewed as a movie by clicking the
“Run Movie” button. For most SEI passes it is best to view the data using the LOG scaling
option. There is also a thumbnail viewer available.
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Plots of intensity, moments, and engineering housekeeping data can be created using the
“Plot” button along with the dropdown box to its right. By default plots appear in the GUI,

but selecting the “New Window” checkbox allows plots to be created in a new, larger
window.

Options for outputting plots to file are located in the “File” menu. For postscript output, open
a file using “File-> Start Postscript File Log”, create a plot using the “Plot” button, then close
the postscript file via “File>End Postscript File Log”.
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Figure 20: SEI Tools GUI

The information contained herein is proprietary to the University of Calgary
ePOP-5025



UNIVERSITY OF e-POP Data User’'s Manual — Rev A

CALGARY Page -42 -

= Lo oo o= S

e—POF SEl — February 1, 2015
T T T T T 7T T T T T T T T T T | T T T T T T T T T I T T T T T T T T T

20— —

Mean Intensity (DN}

G2:29:45.600 02:31:12.000 02:32:38.400 G2:34i4.800
Time (HH:MM:55.555)

Figure 21: Sample SEI Tools plot

8. e-POP Data Archival

The e-POP science data is archived at many stages during processing. Figure 22 shows
how the e-POP science data is received, stored, archived, and shared.

Copy 1 is the raw, compressed data files that are received by the University of Calgary
from the ground station provider and are saved exactly as they are received.

Copy 2 is the unpacked science and spacecraft bus data that is parsed and evaluated by
the CASSIOPE Mission Operation System (MOS). Spacecraft health and safety is
evaluated using this data, and spacecraft ephemeris products are generated at this level.

Copy 3 is a compressed copy of Copy 2 along with the MOS evaluation products (plots,
reports, etc.) This copy is stored at a separate, secure, off-site location on a different
operating system than Copy 2.

Copy 4 is an exact copy of Copy 2 but on a separate machine.
Copy 5 is comprised of the level 0 data as well as the level 1+ data products that are

generated on the e-POP science data server. The level 1+ data products are versioned and
reproducible from the level O data.
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Copy 6 is an exact copy of Copy 5 but on a separate machine.

Copy 7 is an exact copy of Copy 5 but on a publically-accessible data server. This server is
accessed by cssdp.ca as well as epop-data.phys.ucalgary.ca.

1. Raw data received 3: Spacecraft-level data

from tracking station

l

system offsite copy

2: Spacecraft-level data
system

l

4: Spacecraft-level data
system backup

5: Science data server

6: Science data server

backup

Y

7: Publically-accessible
data server

Figure 22: e-POP data tree

The e-POP Science Operation Center (eSOC) and MOS systems are protected by a
firewall as well as an intrusion prevention and detection system that monitors for and blocks
unauthorized system access. Multiple operating systems are utilized to protect against data
loss and corruption from O/S-dependant virus and/or malware attacks.
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